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Temperature Controller MODBUS SIO Driver

Introduction
This manual describes how to connect the Display and the External Device (target Temp. Controller).

In this manual, the connection procedure is described in the sections identified below:

1 System Configuration
This section lists the types of External
Devices and SIO that you can connect.

& System Configuration” (page 3)

2 External Device Selection
Select a model (series) of the External
Device and its connection method.

&~ 2 External Device Selection” (page 8)

3 || Communication Settings

This section shows setting examples for
communicating between the Display and
the External Device.

&~ "3 Communication Settings" (page 9)

4 || Setup ltems

This section describes communication
setup items on the Display.

Set the Display’s communication settings
in GP Pro-EX or in off-line mode.

Fny Setup Items" (page 25)

5 || Cable Diagrams

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagrams" (page 30)

Operation
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Temperature Controller MODBUS SIO Driver

1 System Configuration
The following table lists system configurations for connecting Fuji Electric Co.,Ltd. External Devices and the
Display.
Cable
Series CPU Link I/F SIO Type | Setting Example ,
Diagram
e + | " Cable
PC Loader Port RS-232C Setting Example 1 Diagram 1"
on CPU Unit (page 9) (page 30)
PXH PXHOOOOO-OOmOO™!
S .+ | " Cable
Port on CPU Unit ES-4i22)/485 (Settlnlgll)ixamp le2 Diagram 2"
wire page (page 32)
s . | " Cable
. PC Loader 1.’ort RS-232C Setting Example 3 Diagram 1"
PXG400O0mO-00000-0 2 | on CPU Unit (page 13) (page 30)
PXG PXGsOO0mMO-00000-0%?
PXGoOOMO-00000-07 ] "Setti n | " Cable
Port on CPU Unit ésvjifez)M% (S;tt;n{gsl)ixamp led Diagram 3"
pag (page 45)
PXR30000-00mMO0-0°
PXR4OOOO-OCIMOT 34" I . | " Cable

m'?oﬂx) PXRSOOOO-O0MOO | Port on CPU Unit 25'452)/ 485 (S:“‘“lg7])3"amp'e 3" | Diagram 3"
PXR70000-OOMOO" wire page (page 45)
PXROOOOO-O0O0MOO™

PXR I + | " Cable

(NoAuto- | PXR4OOOO-O0O0MOO 34" | Port on CPU Unit gS;lifj)MSS (S;tt;nlgg])Example 6 Diagram 3"

F1X) pag (page 45)
PUMADLDDOO-00000 PC Loader Port "Setting Example 7" Cable "
PUMBOOOO-OOOOO . RS-232C Diagram 1

on CPU Unit (page 21)

PUM PUMEOOOO-O0 (page 30)
puMvVOOOO-O0000OO _ " Cable
pPUMNOOOO-OOOOO Port on CPU Unit RS-4.22/485 Setting Example 8 Diagram 4"
PUMTOOOO-00000 (2 wire) (page 23)

(page 58)
*1  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following code:
R (RS-485)
*2  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485)

V (RS-485 + Digital input (No.1))

K (RS-485 + RSV1)

J(RS-485+ CT1)

F (RS-485 + Digital input (No.1) + RSV1)
U (RS-485 + Digital input (No.1, 2, 3))

*3  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485 Modbus interface)
V (RS-485 Modbus interface + Digital input 1 point)

*4  PXR4 Socket type cannot be connected because it lacks a serial port option.
*5  CPU Unit released in July 2001 or later
*6  CPU Unit released in June 2001 or earlier
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B Connection Configuration

¢ 1:1 Connection

)

Display

¢ 1:n Connection

)

External Device

1

] ]

l

| |

J )

u

External Device External Device External Device

J

Display Maximum number of External Devices: 16
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Temperature Controller MODBUS SIO Driver

m |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Usable port
Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)

coM1™!', comz,
PS-2000B cOM3*L COM4 - -
PS-3450A, PS-3451A, 10 . 1
PS3000-BA, PS3001-8p | COMI, COM2 COM2 CoM2
PS-3650A (T41 model), -
PS-3651A (T41 model) CoMI ) )
PS-3650A (T42 model), *1%) *1%) *]%)
PS-3631A (T42 model) coM1™1"2, com2 COMI COMI
PS-3700A (Pentium®4-M) | COM1*!, cOM2™!, o o
PS-3710A COM3™2 , COM4 COM3 COM3
PS-3711A coM1™!, com2™ com2™ coMm2™
PS4000"3 COM1, COM2 - -

coM1*"2, com2™, 1% 1%
PL3000 COMS3, COM4 COMI COMI
PE-4000B Atom N270 COM1, COM2 - -

COM3™ , COM4™, | cCOM3™, coM4™,

PE-4000B Atom N2600 COMI, COM2 CoMs™ come™ | CoMs™ COME™
PS5000 (Slim Panel Type 4 4 4
Core i3 Model) *> *6 COM1, COM2 COM2 COM2
PS5000 (Slim Panel Type
Atom Model) coM1, com2™7 com2™7 com2™?
*5 %6
PSSOQ% (Enclosed Panel COMI ) )
Type)
PS5000 (Modular Type
PFXPU/PFXPP)"> *6 7 7 o
PS5000 (Modular Type CoMI coMl CoMl
PFXPL2B5-6)
PS5000 (Modular Type *7 *7 *7
PFXPL2BI-4) COM1, COM2 COM2 COM2
PS6000 (Advanced Box) 9 *10 #10
PS6000 (Standard Box) COM1
PS6000 (Basic Box) coM1™ com1™ com1™

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

GP-Pro EX Device/PLC Connection Manual
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Temperature Controller MODBUS SIO Driver

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4  Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5  When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.

When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6  To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

Settings FAQ ID
PFXZPBMPR42P2, RS422/485 change method FA263858
PFXZPBMPR42P2 termination resistor setting FA263974
PFXZPBMPR44P2, RS422/485 change method FA264087
PFXZPBMPRA44P2 termination resistor setting FA264088

*7  Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8  For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PEXZPSCNM122.

*9  In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch settings (PL3000 / PS3000 Series)

RS-232C
DIP Switch Setting Description
1 OFF"! Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

GP-Pro EX Device/PLC Connection Manual 6



Temperature Controller MODBUS SIO Driver

RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF
RS-422/485 (2 wire)
DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON

~|
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Temperature Controller MODBUS SIO Driver

2 External Device Selection

Select the External Device to be connected to the Display.

,j_}f: Welcome to GP-Pro EX [x]
4 Device/PLT
» evice,
GP-Prole |

Mumber of Devices/PLCs |1 3: g
Device/FLC 1

Manufacturer | Fuiji Electric Co. Lid. |L

Series Temp. Controller MODBUS 510 E

Port COM1 I
Biefer to the manual of this Deviee/PLC
Becent Device/PLC

A 13

= Wse System Area Device Infarmation
£iim

QT

Back [B] Communication Settings | Mew Screen I Canicel

Setup Items Setup Description

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the

Number of Devices/PLCs :
display.

Select the manufacturer of the External Device to connect. Select "Fuji Electric

Manufacturer Co.,Ltd.".

Select the External Device model (series) and the connection method. Select "Temp.
Controller MODBUS SIO".

Series In System configuration, make sure the External Device you are connecting is
supported by "Temp. Controller MODBUS SI10".

! System Configuration” (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area Not available for this driver.

GP-Pro EX Device/PLC Connection Manual 8



Temperature Controller MODBUS SIO Driver
|

3 Communication Settings

This section provides examples of communication settings recommended by Pro-face for the Display and the

External Device.

3.1 Setting Example 1
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 9
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP
key located in the operation area on the front of the controller.

Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value
Setting Parameter Setting Value Setup Description
SPD2 384 RS-232C communication speed
BIT2 8o RS-232C bit format

GP-Pro EX Device/PLC Connection Manual 10
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|

3.2 Setting Example 2
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 11
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP
key located in the operation area on the front of the controller.

Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value
Setting Parameter Setting Value Setup Description
STN4 1 RS-485 station No.
SPD4 384 RS-485 communication speed
BIT4 8o RS-485 bit format

GP-Pro EX Device/PLC Connection Manual 12
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|

3.3 Setting Example 3
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 13
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B External Device Settings

External Device communication settings are fixed as indicated below.

Setting Items Setting Value
Communication speed 9600
Data length 8
Stop bit 1
Parity None

GP-Pro EX Device/PLC Connection Manual
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|

3.4 Setting Example 4
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 15
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, or USER key, located in the
operation area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to switch to Monitor Mode.
2 Press and hold SEL key to switch to Setup Mode.
3 Press UP key or DOWN key to display [CoM Ch 9].
4 Press and hold SEL key.
5 Press UP key or DOWN key to display setting parameter.
6 Press SEL key.
7 Press UP key or DOWN key to display setting value.
8 Press SEL key.
9 Press USER key.
10 Reboot the External Device.

@ Setting Value
Setting Parameter Setting Value Setup Description
STno 1 ST No. setting
CoM 960d RS-485 Baud rate/Parity settings
SCC W RS-485 Communication permissions

GP-Pro EX Device/PLC Connection Manual 16
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|

3.5 Setting Example 5
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

pirt ta Bl [Inp:

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

=

GP-Pro EX Device/PLC Connection Manual 17
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value
Setting Parameter Setting Value Setup Description
STno 1 Station No.
CoM 0 Parity setting
PCoL 1 Communication protocol

GP-Pro EX Device/PLC Connection Manual 18
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|

3.6 Setting Example 6
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual D = E

PR Series(NodutoFl) i
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value
Setting Parameter Setting Value Setup Description
STno 1 Station No.
CoM 0 Parity setting
PCoL 1 Communication protocol

GP-Pro EX Device/PLC Connection Manual 20
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|

3.7 Setting Example 7
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 21
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B External Device Settings
For External Device communication settings, use the Station No. Configuration switch on the front of the
controller.

Refer to your External Device manual for details.

1 Set "0" to Station No. Configuration switch.

NOTE » The Station Number is generated by adding 1 (one) to the value set by the Station No.

Configuration switch.

Other communication settings are fixed as below.

Setting Items Setting Value
Communication speed 19200
Data length 8
Stop bit 1
Parity None

GP-Pro EX Device/PLC Connection Manual 22
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|

3.8 Setting Example 8
B GP-Pro EX Settings

© Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 23
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B External Device Settings

For External Device communication settings, use the Station No. Configuration switch on the front of the
controller and Parameter Loader software (PUM Loader).

Refer to your External Device manual for details.

1 Set "0" to Station No. Configuration switch.

NOTE » The Station Number is generated by adding 1 (one) to the value set by the Station No.
Configuration switch.

2 Start up the Parameter Loader software.
3 Select [Control/Event/Analog Module] in the [Module type selection] dialog box.
4 Click [OK].
5 Select the any mode in the [Startup mode] dialog box.
6 Click [OK].
7 Select [Control module]-[Parameter]-[Communication] in the tree view of the main window.
8 Click the setting item to display the selection dialog box of the setting value.
9 Select the setting value.
10 cClick [OK].

11 Transfer the communication settings to External Device.

@ Setting Value
Setting Items Setting Value
RS-485 Parity setting None
RS-485 Communication speed 19.2Kbps
RS-485 Communication permission 1
RS-485 Response interval time 1
Enhanced comm. module (PUMC) connection 0
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4 Setup Items

Set up the Display’s communication settings in GP Pro-EX or in the Display’s off-line mode.
The setting of each parameter must match that of the External Device.

&~ 3 Communication Settings" (page 9)

4.1 Setup Items in GP Pro-EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IFuii Electric Co. Ltd. Series Temp. Contraller MODBLS 510 Port  |COR1
Text Data Mode I‘I_ LChange

Communication Settings

510 Type ¥ R5232C = RS 422/485(2wire] = RS 422/485(4wire]
Speed lm

Data Length 7 [l

Parity ' NONE " EVEN . 0DD

Stop Bit 1 -

Flows Contral ' NONE " ER[DTR/CTS) KON /XOFF

Timeout m [zec)

Fietry m

wiat To Send [0 = ms)

Rl #vCC & Rl WL

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
[&] 1 Jrc [t [Series=F<G Series Station No.=1
Setup Iltems Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
In the communication setting, confirm the serial interface specifications of the Display and
SIO Type set [SIO Type] correctly.
If you select an SIO type the serial interface does not support, we cannot guarantee the
operation.
Please refer to the manual of the Display for more detail on the serial interface
specifications.
Speed Select communication speed between the External Device and the Display.
Data Length Display data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.

Continues to the next page.
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Setup Items Setup Description
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
' Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Ret In case of no response from the External Device, use an integer from 0 to 255 to enter how
Y many times the Display retransmits the command.
Wait To Send Use an integer fro.m. 0 to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RIVCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.

Please refer to the manual of the IPC for more detail.

¢ Refer to the GP-Pro EX Reference Manual for Indirect Device.

GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

W Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Series |PXG Series |

If you change the series, please reconfirm all address settings.

Station No. |1 3:
Default |

0K () Cancel |

Setup Items Setup Description
Series Select the series of the External Device.
Station No. Use an integer from 1 to 255 to enter the Station number of the External Device.
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4.2 Setup Items in Off-line Mode

* Refer to the Maintenance/Troubleshooting manual for information on how to enter off-line

mode or about the operation.

Cf. Maintenance/Troubleshooting Manual "Off-line Mode"
* The number of the setup items to be displayed for 1 page in the off-line mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings] in off-line mode.

Touch the External Device you want to set from the displayed list.

| Cormm, Device Option

Temp, Controller MODBUS SI0 [GOM1] Page 1/1
SI0 Type RS422/485(2wire) e
Speed 96m0 =i
Data Length 8
Parity NONE EVEN e (DD
Stop Bit o | »
Flow Gontrol JNONE >
Timeout(s} T w | a
Retry 7w | A
Wait To Send(ms) 1 | a

. 2088/12/22
| Enit | Back 15:12:18

Setup ltems

Setup Description

SI0 Type

Select the SIO type to communicate with the External Device.

In the communication setting, confirm the serial interface specifications of the Display and
set [SIO Type] correctly.

If you select an SIO type the serial interface does not support, we cannot guarantee the
operation.

Please refer to the manual of the Display for more detail on the serial interface
specifications.

Speed

Select the communication speed between the External Device and the Display.

Data Length

Display data length.

Parity

Select how to check parity.

Stop Bit

Select stop bit length.

Continues to the next page.

GP-Pro EX Device/PLC Connection Manual 27



Temperature Controller MODBUS SIO Driver

Setup Items Setup Description
Select the communication control method to prevent overflow of transmission and reception
Flow Control
data.
' Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Ret In case of no response from the External Device, use an integer from "0 to 255" to enter how
Y many times the Display retransmits the command.
Wait To Send Use an integer from "0 to 255" to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.

W Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the

External Device you want to set from the displayed list, and touch [Device].

Cormnm, Device Option
Temp, Controller MODBUS SI0 [GoM1] Page 1/1
Device/PLC Name [PLCI ==
Series PHR Series{AutoFIH}

Station No. | 1 v al

Euit Back

Setup Items

Setup Description

Device/PLC Name

Select the External Device to set. Device name is a title of the External Device set with GP-
Pro EX. (Initial value [PLC1])

Series

Display the series of the External Device.

Station No.

Use an integer from 1 to 255 to enter the Station number of the External Device.
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Option].

Setup ltems Setup Description

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE * GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not
have the [Option] setting in the offline mode.
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5 Cable Diagrams

The following cable diagrams may be different from cable diagrams recommended by Fuji Electric Co.,Ltd.

Please be assured there is no operational problem in applying the cable diagrams shown in this manual.

* The FG pin of the External Device body must be D-class grounded. Refer to your External Device manual for
more details.

* The SG and FG are connected inside the Display. When connecting the External Device to the SG, design
your system to avoid short-circuit loops.

» Connect an isolation unit if the communication is not stable due to noise or other factors.

Cable Diagram 1

Display

Cabl Not
(Connection Port) avie oles

GP3000 (COM1)
GP4000"! (COM1)
SP5000"2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1) 1A Loader connecting cable by Fuji Electric Systems Co., Ltd.™
STM6000 (COM1)
STC6000 (COM1)
LT3000 (COM1)
IPC™

PC/AT

GP-4105 (COM1) User-created cable
GP-4115T (COM1) 1B +
GP-4115T3 (COM1) Loader connecting cable by Fuji Electric Systems Co., Ltd."

*1  All GP4000 models except GP-4100 Series and GP-4203T
*2  Except SP-5B00

*3 Org:the COM port which can communicate by RS-232C can be used.
"® |IPC COM Port" (page 5)

*4  The loader connecting cable differs, depending on the series.

Series Loader connecting cable type
PXH ZZPPXH1*TK4H4563
PUM PUMZ*L01
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1A)
Display Display side External Device side
D-Sub 9pin $2.5 triple pole miniature jack
1P —-=
Loader connecting cable
NOTE I + Connect the loader connecting cable to the PC loader port of the External Device.
1B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal : Pin Signal
Display name name Display side External Device side

RD(RXD) 2 RD(BXD) D-Sub 9pin $2.5 triple pole miniature jack
SD(TXD) 3 [SD(TXD)

ER(DTR) 4 |ER(DTR) @ o

SG 5 SG Loader connecting cable
RS(RTS) — 7 |RS(RTS)
CS(CTS) i 8 |CS(CTS)
<
User-created cable
NOTE I » Connect the loader connecting cable to the PC loader port of the External Device.

GP-Pro EX Device/PLC Connection Manual
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Temperature Controller MODBUS SIO Driver

Display
. Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
AGP-3302B (COM2) , +
GP-4*01TM (COM1) 2A Terminal block conversion adapter by Pro-face Cable length:
GP-Rear Module (COM1) CA3-ADPTRM-01 500m o less
ST*2 (COM2) *
LT3000 (COM1) User-created cable
2B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
2C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™ (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
CA4-ADPONL-01
2D N
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
- 2E Terminal block conversion adapter by Pro-face Cable length:
CA}'ADETRM'OI 500m or less
User-created cable
2F User-created cable
GP-4106 (COM1) Cable length:
GP-4116T (COM1) 2G User-created cable 500m or less
GP-4107 (COM1) )
GP-4*03T"5 (COM2) 2H User-created cable Cs?)%ﬁf?i?é
GP-4203T (COM1)
GP4000"° (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) ol PFXZCBADTM1™®
SP5000"7 (COM1/2) +
SP-5B00 (COM2) User-created cable
ST6000"8 (COM2) Cable length:
ST-6200 (COM1) 500m or less
STM6000 (COM1)
STC6000 (COM1) 2B User-created cable
PS6000 (Basic Box)
(COM1/2)
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable lenath:
LT-Rear Module (COM1) 2] PFXZLMCBRIRS1 gt

200m or less
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Displa
p. y Cable Notes
(Connection Port)
PE-4000B"1°
PS5000°1° Cable length:
PS6000 (Optional 2K User-created cable 500m or less
Interface)*10
*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
&~ "m |PC COM Port" (page 5)
*5  Except GP-4203T
*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*7  Except SP-5B00
*8  Except ST-6200
*9  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block

Conversion Adapter, refer to Cable Diagram 2A.

*10 Or%the COM port which can communicate by RS-422/485 (2 wire) can be used.

"® [PC COM Port" (page 5)

IMPORTANT I Implement Type D installment to the shield connected to the FG.
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2A)

¢ 1:1 Connection

Display

CA3-ADPCOM-01

¢ 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal Block . .
p— Shield External Device side
Ignal name i
g K ","\‘ Termlnal B|OCk Termination
TERMRX ? FY Pin [Signal name| resistance
RDA Ph A _-' L 100Q2
[ [ “ /\ T 14 *
/1 RDB |e —> 16 -
CA3-ADPTRM-01 SDA .15 SG
SDB :
SG
FG
User-created cable
Display side
Terminal Block . .
- ) External Device side External Device side
Signal name .. Shield Terminal Block Terminal Block o
R X Termination
TERMRX ;% | Pin [Signalname| ~Shield_ Pin |Signal name|resistance
P P 100Q
[ — RDA |« / ™ 14 + 14 +
// ] RDB | il 16 - e 16 -
SDA i 15| s = —— 15 | sG
SDB —l—
SG
FG

v

A

User-created cable

GP-Pro EX Device/PLC Connection Manual

34



Temperature Controller MODBUS SIO Driver

2B)
* 1:1 Connection
Display side External Device side
. D-Sub 9pin (socket) Terminal Block -
Termination . Termination
resistance | Pin | Signal name Shield Pin [Signal name| resistance
100Q ST 100Q
1 RDA |[¢——A——> 14 +
Display 2 RDB |e—: /\_._‘..> 16 -
3 | SDA |— . —— 15 | SG
7 | sbB |— P
5 SG . P
4 ERA ::l
8 | CSA [*+= o
9 ERB :’
6 | CSB [+ Ll
.......... )(’
shel | FG |—T
¢ l:n Connection
Display side External Device side External Device side
.. D-Sub 9pin (socket) Terminal Block Terminal Block -
Termination i . Termination
resistance | Pin |Signal name Shield Pin [Signal name Shield Pin [Signal name| resistance
100Q PRV AN 10002
1 RDA 14 + 7 o 14 +
Display 2 | ROB 6| - | S—{1e | -
3 | SDA 15 | SG [—~——=— 15| SG
7 |spB bt 08 T 1
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
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2C)
¢ 1:1 Connection

Display side

Terminal Block . .
External Device side

Signal name i i
Dol 9 Sh|e|d’ Terminal Block i oo
play TERMRX — o Pin |Signal name| resistance
: A i 100Q
[ [ RDA |e / ——> 14 + %
CA3-ADPTRM-01|  SDA : : 15 SG
CA4-ADPONL-01 H :
SDB .
SG ; ;
FG
User-created cable
¢ 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block Termination
Display TERMRX |—+ e Pin [Signalname| ~ Shield Pin [Signal name| resistance
; P ST i) 100
[:| RDA e /A.',=14 + A 14 + =
//:' RDB |« \—:—E>16 - <—J\—-—>16 -
CA3-ADPTRM-01 |  SDA L 15 SG — +— 15 SG
CA4-ADPONL-01 SDB m=- ';l_
SG
FG

v

A

User-created cable
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2D)
¢ 1:1 Connection

Display side

D-Sub 9pin (plu
(plug) External Device side

Pin | Signal name Shield Terminal Block -
DISp|ay ST EEm 3, . Ter'mlnatlon
1 |TERMRX [— Pin [Signal name| resistance
: N 1000Q
2 RDA [e / ——> 14 + %
7 RDB |e= \—~—> 16 -
3 | SDA = . —+— 15 | SG
CA4-ADPONL-01 H v
8 SDB T .
5 SG ‘ Vi
Shell FG —T
User-created cable
¢ l:n Connection
Display side
D-Sub 9pin (plug) External Device side External Device side
Pin | Signal name Shield Terminal Block Terminal Block . on
Display 1 |[TERMRX [—— P Pin |Signal name| ~ Shield Pin |Signal name ;%S(Ea”ce
2 | ROA |& /A sl 14 |+ AT | El
7 | ROB | \——> 16| - e Vil | -
3 | spa .+~ 15]| sG ——+—15| sG
CA4-ADPONL-01 8 SDB --..;l_
5 SG
Shell FG

A\

A

User-created cable
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2E)
¢ 1:1 Connection

Display side

Terminal Block External Device side

Signal name Shield Terminal Block o
) P K Termination
Display TERMRX — SN Pin |Signal name| resistance
RDA @ .: A .: ‘-‘ » + 100Q
[ = AR =
/1 RDB |& ——> 16 -
CA3-ADPTRM-01 SDA | : — 15 SG
CA3-ADPCOM-01 SDB ' H
SG :
FG
User-created cable
¢ l:n Connection
Display side
Terminal Block . External Device side External Device side
Signal name ____§_h_'_elc_i _____ Terminal Block Terminal Block Termination
Display TERMRX [—* £ % | Pin [Signal name Shield Pin [Signal name] resistance
! £ T i 100Q
< g
[ 1 RDA 14 + ~ > 14 + %
// L1 RDB 16 - e e -
CA3-ADPTRM-01 SDA 15 SG —— 15 SG
CA3-ADPCOM-01 soB |2 i T 1
SG
FG

User-created cable
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2F)

¢ 1:1 Connection

Display side External Device side
Termination D-Sub 9pin (socket) . Terminal Block Termination
resistance | Pin |Signal name Shield Pin [Signal name| resistance
1000 1000
1 |DATA+ [¢— A——> 14 + %
Display 2 [DATA- 4_._/ L-» 16 -
3 | NC : i —— 15 | SG
7 | NC | P
5 [GND(SG) — P
4 ERA ::l
8 CSA
9 ERB :l
6 | CSB [+ Ll
.......... él'
shell | F6 |—7T
¢ l:n Connection
Display side External Device side External Device side
Termination 2-ouP 9pin (socket) . Terminal Block . Terminal Block . . on
resistance | Pin |Signal name Shield Pin |Signal name Shield Pin |Signal name| resistance
1 [pATAr |« | + Al |« o
Display % 2 DATA— 16 _ 4_§J\_;_';.> 16 _ %
3 | NC 15 | s6 =——{ 15[ sG
7 [ ne | 00 0 T 1
5 |GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
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2G)

¢ 1:1 Connection

Display side External Device side
Terminal block Terminal Block I
o ) Termination
Termination - [Sjgnal name Shield Pin |Signal name| resistance
resistance*1 REEEELCEEEEETY 100Q
% RDA |[e—4—A—> 14 + %
Display RDB |e— / .l 16 -
SDA (— ; 15 | SG
SDB H
SG_|— 5
CSA <——|', '
ERB : ;
CSB <—J ;
¢ l:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block -
. X Termination
Termination | Signal name Shield Pin [Signalname| ~ Shield Pin [Signal name| resistance
resistance*1 PR A 100Q
RDA 14 + [ b 14 +
Display RDB 16 _ <—J \~—» 16 _
SDA 15| s& H—— = 15| sa
sbB |+ 1+ 7T 1
SG
ERA
CSA
ERB
CSB

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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2H)

¢ 1:1 Connection

Display side External Device side
Termination D-Sub 9pin (plug) . Terminal Block Termination
resistance Pin | Signal name Shield Pin [Signal name| resistance
1000 P 1000
. LINE(+) [+ o 14 + %
Display 8 LINE(-) 4_'_/\_‘_._, 16 -
1 NC i~ 15| sG
e [ w | § 0
5 | GND(sG) [
4 | RsRTS) | |
6 5V
7 NG
9 NC i L
Shell FG —
¢ 1:n Connection
0.5 5 i) SmaDeese el Dot e
T?;”Qi:tim Pin | Signal name Shield :i;mlr;?lgnalz:me Shield Pin |Signal name ::;in;tigigzn
1000 [ e Uy pa PP N ——( 1000
Display % 8 | LINE() 16 _ 4_,J \_._,> 16 _ %
1| e . 15| s6 15 | sG
2 NC 2 A 1
5 | GND(sG) |— : B
4 | RsRrs) |
6 | sv
7 | e Lol
s | nc |
Shell | FG I e >

The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

ik

e In COM on the GP-4107, the SG and FG terminals are isolated.
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21)
¢ 1:1 Connection

Display

Display side
Terminal Block

Temperature Controller MODBUS SIO Driver

External Device side

[

PFXZCBADTM1

¢ 1:n Connection

Display

[ ]
//I:I

PFXZCBADTM1

Signal name Shield :
g b - Terminal Blook oo,
TERMRX : P Pin [Signal name| resistance
RDA i A .: Sy + 1000
[ “ /\ T 14 %
/1 RDB e > 16 —
SDA |~ — 15 SG
SDB
SG
FG
User-created cable
Display side
Terminal Block . .
- . External Device side External Device side
Signal name ... Shield Terminal Block Terminal Block o
K X - Termination
TERMRX /% | Pin |Signalname| Shield_ Pin |Signal name]resistance
RDA |e /A :.' '-:= 14 + ‘:' A :.' —»{ 14 + 100Q
AR oy e VAN P16 | -
SDA — 15 | sG |- —~— 15 | SG
SDB 1
SG
FG

v

A

User-created cable
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2J)

¢ 1:1 Connection

Display

(1)

¢ 1:n Connection

Display

External Device side

Terminal Block

Termination
Pin [Signal name| resistance
D1 1000
DO 16 _
GND 15 SG

External Device side

Termination External Device side
;ezs(;;tance Terminal Block Terminal Block Termination
(1/4W) . ) : . .
\ Pin |Signal name Shield Pin |Signal name| resistance
D1 PERAY WA 2200(1/4W)
g 14 + <+ v 14 +
—~ 6| - & e | -
(1 15 SG N — 15 SG
- o
User-created Cable
Number Name Notes

(M

RJ45 RS-485 Cable (5m) by Pro-face

PFXZI.MCBRIJRS1
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43



2K)

¢ 1:1 Connection

Temperature Controller MODBUS SIO Driver

Display side External Device side
Termination D-Sub 9pin (socket) Terminal Block Termination
resistance | Pin |Signal name Shield Pin |Signal name| resistance
009 1 pATAs e— AT T s
Display 1 |DATA- <—.—/ \——> 16 -
3 NC ; 15 | SG
7 | NC i
5 | GND
4 | NC :
8 | NC
9 | NC :
6 | NC \
Shell FG
¢ l:n Connection
Display side External Device side External Device side
Termination D-Sub 9pin (socket) Terminal Block Terminal Block Termination
resistance [ Pin |Signal name Shield Pin [Signalname| ~ Shield Pin |Signal name| resistance
T2 [DATAY le— R VAEN I P P , 14 e
Display % 1 |DATA- 4——/L—> 16 - <—J\~—» 16 - %
3 | nc | :" 15 | sG |———i+115 | s
7 | nc | A 1
5 | GND [— :
4 | N | '
8 | NnC | i :
9 NC '
6 | NC \ ,
Shell FG
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Display
. Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
AGP-3302B (COM2) , +
GP-4%01TM (COM1) 3A Terminal block conversion adapter by Pro-face Cable length:
GP-Rear Module (COM1) CA3-ADPTRM-01 500m or less
ST*2 (COM2) +
LT3000 (COM1) User-created cable
3B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
3C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000*3 (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
CA4-ADPONL-01
3D
+
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
- 3E Terminal block conversion adapter by Pro-face Cable length:
CA3'ADJI:TRM'01 500m or less
User-created cable
3F User-created cable
GP-4106 (COM1) Cable length:
GP-4116T (COM1) 3G User-created cable 500m or less
GP-4107 (COM1) )
GP-4*03T*5 (COM2) 3H User-created cable chgrlg L‘?’ég;
GP-4203T (COM1)
GP4000"° (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) . PFXZCBADTM1™
SP5000"7 (COM1/2) +
SP-5B00 (COM2) User-created cable
ST6000"® (COM2) Cable length:
ST-6200 (COM1) 500m or less
STM6000 (COM1)
STC6000 (COM1) 3B User-created cable
PS6000 (Basic Box)
(COM1/2)
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable lenath:
LT-Rear Module (COM1) 3] PFXZLMCBRIJRS1 gt

200m or less
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Displa
p, v Cable Notes
(Connection Port)
PE-4000B"!°
PS5000*1° Cable length:
PS6000 (Optional 3K User-created cable 500m or less
Interface)*10
*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B
*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
5" "m |PC COM Port" (page 5)
*S  Except GP-4203T
*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*7  Except SP-5B00
*8  Except ST-6200
*9  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block

Conversion Adapter, refer to Cable Diagram 3A.

*10 Org:the COM port which can communicate by RS-422/485 (2 wire) can be used.

"® |IPC COM Port" (page 5)

IMPORTANT IR l’::in;lsnal number used for communication differs depending on the External Device
Terminal numbers corresponding to each series are shown below. SG terminals are
not available for these series. Apply masking using insulation tape, etc. Implement
Type D installment to the shield connected to the FG.

Series + -
PXG4 7 8
PXG5/PXG9
PXR3 15 14
PXR4/PXR7 7
DVDR/DVYDO 1 o]
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3A)

¢ 1:1 Connection

Display side
Terminal Block

External Device side

Signal name Sh'e"d ______ Terminal Block
Display : B Vs Termination
TERMRX ; fo Signal name resistance
P A L Ly 100Q
< r ; +
(S e L/ —=
A — RDB e — -
CA3-ADPTRM-01 SDA = v
CA3-ADPCOM-01 SDB : Voo
SG
6 |
User-created cable
¢ 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signal name ___.Shield Terminal Block Terminal Block o
; ./ K Termination
Display TERMRX [— ;% |Signalname[ Shield Signal name|  resistance
A T N i 1000
[ (- RDA ‘ / g + +
// L] RDB  [e+f1 L e M
CA3-ADPTRM-01 SDA |+ y
CA3-ADPCOM-01 SDB T o 1
SG N k ‘.‘.,"’
6

v

A

User-created cable
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3B)
¢ 1:1 Connection
Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination . . ; . Termination
resistance Pin  |Signal name Shleld Signal name|  resistance
1000 1 | RDA |e—4—A—— + %1009
3 | SbA |— P
7 | sbB {— P
5 SG ; P
4 ERA ::l
8 CSA
9 ERB :l
6 | CSB [« L
.......... y’
shell | FG |—T
¢ 1:n Connection
Display side External Device side External Device side
. D-Sub 9pin (socket) Terminal Block Terminal Block
nati . Terminati
eaistance Pin [Signal name Shield Signalname| ~__Shield |Signal name ,;2212:62’"
1002 1 | RDA fe——A ol +  Je—AT 4 %1009
Display 2 RDB |e—: /\_._,,' - -
3 | sbA . | L
7 | sbB |— 1
5 | sG | P
4 ERA ::I
8 | csA [«
9 | ERB :|
6 | cSB [+ i
shel | FG |—Y" "
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3C)

¢ 1:1 Connection

Display side
Terminal Block External Device side

Signal name Shield Terminal Block

D|Splay TERMRX Lo '-’"‘ S|gna| name Termination

resistance
RDA

1 > + %100(2
/L—1| RDB [

A

CA3-ADPTRM-01 SDA
SDB
SG \

FG 17T ’

CA4-ADPONL-01

A
\ 4

User-created cable

¢ 1:n Connection

Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block
Display LTI I : ’ Termination
TERMRX 7 \ Signal name - _Shield_ b [Dlgnalnamel cictance

+ %’I 00Q

g

I [ RDA |« A >+ ;

// :l RDB <« / \'_> - 4—;J
CA3-ADPTRM-01 SDA —-
SDB [ :

CA4-ADPONL-01

SG ‘\ .
FG |—1 7T

A

A\ 2

User-created cable
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3D)

1:1 Connection

Display side
D-Sub 9pin (plug)

Temperature Controller MODBUS SIO Driver

External Device side

Pin | Signal name Shield Terminal Block
Displa e - - L
play 1 |TERMRX |— 7 [signalname|  Termination
/ N resistance
2 RDA |t / —p + %1009
7 RDB |« \—-> -
3 SDA :
CA4-ADPONL-01 . : :
8 SDB - Vo
5 SG
shel | FG  |—1
User-created cable
¢ l:n Connection
Display side
D-Sub 9pin (plug) External Device side External Device side
Pin | Signal name Shield Terminal Block Terminal Block
Display 1 | TERMRX 7 [sonalname]  shield - [signalname]  Termeton
2 RDA |« /A Ly o+ & A——— 4 _grmog
7 | ROB |e \-—» - 4—/ sl
3 SDA | Lo L
CA4-ADPONL-01 8 SDB .' _l_
5 SG
shel | FG —1 T

A

User-created cable

\4
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3E)
¢ 1:1 Connection
Display side
Terminal Block . )
Shield External Device side
Signalname| ___Shield Terminal Block
Display TERMRX —- Signal name| ~ Termination
B A I resistance
<+ + P + 100Q2
(S et 1L/ —=
/L1 RDB |e — -
CA3-ADPTRM-01 SDA | P
CA3-ADPCOM-01 SDB : Voo
SG Y
Fe
User-created cable
¢ l:n Connection
Display side
Terminal Block
ermina’ Bloc Shield External Device side External Device side
Signalname| . °M"®____ Terminal Block Terminal Block
Display TERMRX [ J % Signal name Shield Signal name| ~ Termination
RDA | RN n T N resistance
[ —1 ‘:. / ; -:' :- :' ' %‘IOOQ
// 1 RDB |« s - e s
CA3-ADPTRM-01 SDA '-\ ;"
CA3-ADPCOM-01 SDB -" ‘: :' -------- j_
SG S
Fe |

v

User-created cable
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3F)

¢ 1:1 Connection

DiSplay side External Device side
D-Sub 9pin (socket) Terminal Block
Termination . f inati
. ; Termination
resistance Pin Sigral name Shleld, Signal name resistance
1009% 1 |DATA e TR T %1009
Display 2 DATA- <_;'_/\_"_'... -
3 | NC | P
7 NC ; P
5 |GND(SG)| :
4 ERA ::l
8 | CSA |« Pl
9 | ERB :| T
6 | CSB [+ Ll
Shell | FG |—T""777" "
¢ 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
Termination f . i . f . Termination
istnee | _Pin__|Signalname Sh'e'd Signalname|  _ Shield  ~ |Signalname] S0
100Q 1 DATA+ |« " A " “ + <t " A n “ > + 100Q
Display % 2 DATA- |« -" /\_:._":_. - 4—;J\:—‘:‘P - %
3 | NG| i 4 L
7 | N | . 1
5 |oNDisG)| P
4 ERA ::I
8 | CSA |+
9 | ERB :| ;
6 | CsB [+ Vi
Shell | FG | — T B
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30)

¢ 1:1 Connection

Display side External Device side
Terminal block Terminal Block
Sinal Shield Signal Termination
L Ignal nam Ignal nam i
Termination gnainamey ~ CUET R gnainame|  resistance
resistance*1 RDA |« " A AN + 100Q
Display % RDB |€—- / L _ %
SDA - o
SDB (— P
SG : P
ERA ::l
CSA |+ b
ERB :l‘, Vol
CSB - v
¢ 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block
; ) Terminati
Termination | Signal name Shield Signalname| ~_Shield  [Signal name]  eaistancoe
resistance*1% RDA —ip . ".“.l= + 4"' A :' ‘: . + %1009
Display RDB |« / LT C e [
SDA Lot B s
spB_ P 1
se | i
ERA ::I
CsA -
ERB :| I
CSsB L)

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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3H)

¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (plug) Terminal Block
Termination - : inati
resistance Pin | Signal name . -Sk_“elfj . Signal name -rl;eesriglg]:;gm
100Q “«—L A IS
Displa B P
s 8 | LNE() [+ i
1 NC : Pl
2 NC ] P
5 GND(SG) | P
4 RS(RTS) | ! b
6 5V : v
7 NC : Vo
9 NC \ v
Shell G 17T i
¢ 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block Terminal Block
Termination Pi Signal hield ’ ; - Termination
resistance " one name ,...S..I:a....., Slgnal name '___S_hl_e_lt_:i_'h Slgnal name resistance
1009% 3 LINE(+) |e—t—p— +  [e—A— _;;009
Display 8 LINE(-) <ﬁ—/ \—‘—» - «J \—~> -
2 | no | P L
5 |enpse) | i
4 RS(RTS) | ! b
6 5V : Lo
7 NC : L
9 NC | Ll
Shell 6 —T T :

IMPORTANT B The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE I * In COM on the GP-4107, the SG and FG terminals are isolated.
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3l)

¢ 1:1 Connection

Display side

Terminal Block External Device side

Signal name Sh'9|d _____ _ Terminal Block
Disola . N . Termination
play TERMRX . Signal name resistance

=y AN e

A 4

PFXZCBADTM1 SDA _"
SDB - \
SG N

FG _T ------------- ”

A
v

User-created cable

¢ 1:n Connection

Display side
Terminal Block ) External Device side External Device side
Signal name .. Shield  Terminal Block Terminal Block
i v N Termination
Display TERMRX — ;'\ |Signalname| _ Shield Signal name| resistance
- NN PSRN 1000
5] =T/ —{7
// (- RDB [T+ — - . — -
PFXZCBADTM!1 SDA _" : % ;
SDB [ Vo _l_
SG o
Fe |1

A

User-created cable
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3J)

1:1 Connection

Display

1:n Connection

External Device side
Terminal Block

Signal name Termination
D1 resistance
+ %1 00Q
@:/ Do N

(1)

Termination External Device side

External Device side

resistance Terminal Block Terminal Block
2200(1/4W) Signal name Shield Signal name| ~ Termination
Display D1 TR resistance
+ o 4 220Q(1/4W)
o = e T %
g} - -
User-created Cable
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
1) PFXZLMCBRIJRS1
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3K)

¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Terg:gzt;%g Pin |Signal name Shleld’ Signal name Esri’:tigﬁtcig”
1006 % 2 |DATA+ je——A—"3 ¢+ %,mog
Display 1 |DATA- <—.—/ \——+ -
3 [ Nnc |
7 | NC | P
5 | GND |
4 | Nne | o
8 | NC | i o
o [ N | i
6 | nc |
shel | FG |—T 7 g
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
T‘igii;ztrigl Pin |Signal name Sh|eld’ Signalname| ~ _ Shield | Signal name :j;{‘;:gﬁﬂg”
100Q 2 |DATA+ le——-A— + Ay 1000
Display % 1 |DATA- 4—/ \——-» - «—/ \—-> - %
s [ne | P G
2 G [ R A ad
5 |GND | i
s lne] i
8 | NC | i Lo
9 NC Lo
6 | Nnc |
shel | FG |—T 777777 ’
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Display
. Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
AGP-3302B (COM2) _ -
GP-4*01TM (COM1) 4A Terminal block conversion adapter by Pro-face Cable length:
GP-Rear Module (COM1) CA3-ADPTRM-01 500m or less
ST*2 (COM2) *
LT3000 (COM1) User-created cable
4B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
4C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000" (COM2) + Cable length:
User-created cable 500m or less
Online adapter by Pro-face
4D CA4-AD-I:ONL-0 1
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
- 4E Terminal block conversion adapter by Pro-face Cable length:
CA3'ADJI:TRM'01 500m or less
User-created cable
4F User-created cable
GP-4106 (COM1) Cable length:
GP-4116T (COMI) 4G User-created cable 500m or less
GP-4107 (COM1) )
GP-4*03T"5 (COM2) 4H User-created cable Scoa‘glls i‘;nlit:;
GP-4203T (COM1)
GP4000"° (COM2) RS-422 Terminal Block Conversion Adapter by Pro-face
GP-4201T (COM1) al PFXZCBADTM1™
SP5000"7 (COM1/2) +
SP-5B00 (COM2) User-created cable
ST6000"3 (COM2) Cable length:
ST-6200 (COM1) 500m or less
STM6000 (COM1)
STC6000 (COMI) 4B User-created cable
PS6000 (Basic Box)
(COM1/2)
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face Cable length:
LT-Rear Module (COM1) 4] PFXZLMCBRIJRS1 st

200m or less
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Display

Cable Notes
(Connection Port)

PE-4000B™1°

PS5000*10 Cable length:

4K User-created cable

PS6000 (Optional 500m or less

Interface)* 1o

*]
%
*3
*4

*5
*6
*7
*8
*9

All GP3000 models except AGP-3302B
All ST models except AST-3211A and AST-3302B
All GP3000 models except GP-3200 series and AGP-3302B

Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
5" "m |PC COM Port" (page 5)

Except GP-4203T

All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
Except SP-5B00

Except ST-6200

When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 4A.

*10 Org}the COM port which can communicate by RS-422/485 (2 wire) can be used.

"W |IPC COM Port" (page 5)
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4A)

¢ 1:1 Connection

Display side
Terminal Block . )
, Shield External Device side
Signalname | SN lela . Terminal Block
Display TERMRX — Signal name Termination
R N K \ resistance
[ | RDA :- / :. -: > A(+) % 100Q
7@ RDB [« ——> B(-)
CA3-ADPTRM-01 SDA = : SG
CA3-ADPCOM-01 SDB . !
SG
FG
User-created cable
¢ 1:n Connection
Display side
Terminal Block . External Device side External Device side
Signal name Sh'eld_ Terminal Block ~ Terminal Block
Disol K K K - - Termination
ISplay TERMRX ; P Signal name | Signal name resistance
[ ] RDA /A '-. > A(+) A(+) %1009
// ] RDB [ T : B(-) B(-)
CA3-ADPTRM-01 SDA —“ : SG SG
CA3-ADPCOM-01 SDB L Y
SG -
FG

A

User-created cable

A\ 4

NOTE I

+ Connect External Devices using side connectors.
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4B)

¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Toonens [P [sedee]  sweg - [Soane | Temoee
100Q 1 RDA [¢—9—A——> A(+) 1000
Display % 2 RDB : /\_.'_I‘.I_> B(-) %
3 | sbA : SG
7 SDB
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
* 1:n Connection
Display side Extemal Device side External Device side
D-Sub 9pin (socket) Terminal Block ~ Terminal Block
Tf;gi;z:zg Pin  [Signal name Shle|dA Signal name | Signal name rTeesri’;::é:’”
100Q 1 RDA [e——A > A(%) A(+) %1009
Display g 2 RDB |e—: /\_‘_‘_> B(-) B(-)
3 | sbA L — SG SG
7 SDB
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell [ FG

NOTE + Connect External Devices using side connectors.
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4C)
¢ 1:1 Connection

Display side
Terminal Block

External Device side

Signal name Shield Terminal Block

Display TERMRX Signal name Termination
A resistance

[ —] RDA / > A(+) ;\3;1009

7& RDB \._‘_, B(-)

CA3-ADPTRM-01 SDA SG

SDB

SG

FG

~

A

A

CA4-ADPONL-01

A
\ 4

User-created cable

¢ 1:n Connection

Display side

Terminal Block External Device side External Device side

Signal name Shield Terminal Block ~ Terminal Block
Display TERMRX —— : ?\‘ Signal name | Signal name Termination
[ =] _Rea < RN RV A(+) %;%%?nce
/ L1l roB |« / \4—‘—> B(-) B(-)
CA3-ADPTRM-01 | SDA : E SG SG
CA4-ADPONL-01 SDB
SG
FG

A
\4

User-created cable

NOTE » Connect External Devices using side connectors.
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1:1 Connection

Display side
D-Sub 9pin (plug)

Temperature Controller MODBUS SIO Driver

External Device side

Pin | Signal name Shield Terminal Block
Display 1 TERMRX '"""""",’,‘\ S|gna| name Termination
h i resistance
2 RDA [ /* ——>  A(+) %1009
7 RDB [« \—~—> B(-)
3 | sbA | ; SG
CA4-ADPONL-01 H H
8 SDB T
5 SG - ;
Shell FG
User-created cable
¢ 1:n Connection
Display side
D-Sub 9pin (plug)
- - External Device side External Device side
Pin [ Signal name Shield Terminal Block ~ Terminal Block
Display 1 |TERMRX [+ 2 [ signaname | signal name | Termination
: H resistance
2 RDA  |& /A > A(+) A(+) %1009
7 RDB | \~——> B(-) B(-)
3 SDA = L SG SG
CA4-ADPONL-01 8 SDB
5 SG
Shell FG

\4

A

User-created cable

NOTE I

» Connect External Devices using side connectors.
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4E)

¢ 1:1 Connection

Display side

Terminal Block External Device side

Terminal Block

Signal name

...............

TERMRX .
RDA |« A > A+)
RDB |e / \—> B(-)
SDA SG
SDB
SG
FG

Termination
resistance

%1 00Q

Display Signal name

=
CA3-ADPTRM-01
CA3-ADPCOM-01

A
v

User-created cable

¢ 1:n Connection

Display side

Terminal Block External Device side Exteral Device side

Signal name _Sh'eld Terminal Block  Terminal Block
Display TERMRX [— £ % | Signalname | Signalname | ~ ermination
: L . resistance
H — RDA [« / AR A(+) %1009
// L] RDB —  B(-) B(-)
CA3-ADPTRM-01 SDA L SG SG
CA3-ADPCOM-01 SDB :
SG
FG

A
A\ 4

User-created cable

» Connect External Devices using side connectors.
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4F)

¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination | Pin  [Sjgnal name Shield Signal name | Termination
resistance f———mo————  oioiiia.-. . resistance
1000 % 1 [DATA* fe——A—"  A() _;;009
Display 2 |DATA-|e—— ‘“——»| B(-)
3 NC : : SG
7 NC
5 [GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block  Terminal Block
Termination Pin  [Signal name Shield Signal name | Signalname [  Termination
resistance 1 ° 1 _....., resistance
100Q 1 |DATA+ je——A — AM) A(+) %1009
Display % 2 |DATA- 4—,—/ \——» B(-) B(-)
3 [ Nne | P SG SG
7 NC
5 |GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
lﬁl » Connect External Devices using side connectors.
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4G)
¢ 1:1 Connection
Display side External Device side
Terminal block Terminal Block
- _ - Terminati
Termination | Signal name .Shield Signalname | *TTe on
resistance*1 RDA | ; A oy A(+) 100Q
Display % RDB |e—: /\_.'_I'.I.> B(-) %
SDA |— i~ SG
SDB |— P
e -+
CSA
ol
CSB [« L
¢ 1:n Connection
Display side External Device side Extemal Device side
Terminal block Terminal Block  Terminal Block
Termination [ Signal name Shield Signal name | Signal name Termination
resistance*1 - . r tance
% RDA |« A———» A+ A(+) %1009
Display RDB  |e— / HELTN R B(-)
SDA L — SG SG
SDB
SG
ERA
CSA
ERB
CSB

NOTE » Connect External Devices using side connectors.

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON

GP-Pro EX Device/PLC Connection Manual 66



4H)

e 1:1 Connection

Temperature Control

ler MODBUS SIO Driver

Display side External Device side
D-Sub 9pin (plug) Terminal Block
Termination Pin | Signal name . Shle|d Signal name 'rl'eesrir;ian:éieon
T 3 LINE(+) [« h AW %1009
Display % 8 LINE(-) 4—-—/ £ B(-)
1 NC :': ' SG
2 NC
5 GND(SG) [
4 RS(RTS) | !
6 5V
7 NC : -
9 NC i L
Shell FG T )
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block ~ Terminal Block
Tf;gg::gg Pin | Signal name Sh'e|d Signal name | Signal name ;‘ZEZ‘:;E”
100Q % LINE(+) | :' A .' . A(+) A(+) %1 00Q
Display 8 LINE(-) <—/ — B(-) B(-)
1 NC : i~ SG SG
5 NG H H
5 GND(SG) : ' !
4 RS(RTS) | i
6 5V :
9 NC | L
Shell 6 — T )

The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

o

* Connect External Devices using side connectors.

* In COM on the GP-4107, the SG and FG terminals are isolated.
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41)

¢ 1:1 Connection

Display side

Terminal Block . )
External Device side

Signal name Shield Terminal Block

’\

Display TERMRX —- S0 Signal name Termination
resistance

= RDA |e A(+) 1000
[, = RDB : /\—» B(-) %

PFXZCBADTM1 SDA ' SG
SDB
SG
FG
User-created cable
¢ 1:n Connection
Display side
Terminal Block . External Device side External Device side
Signal name _____S_r]'_e_'f’___“ Terminal Block ~ Terminal Block
Display TERMRX :.' "_‘ Signal name | Signal name ;‘Zg:f;fn
[ = RDA [« /A H ,:~ A(+) A(+) %1009
//:1 RDB |e s B(-) B(-)
PFXZCBADTM1 SDA | : SG SG
SDB | :
SG N .
Fe |—]

v

A

User-created cable
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4J)

¢ 1:1 Connection

External Device side
Terminal Block

Signal name Termination
Displ resistance
SPey D1 A(+) 100Q
0 =
0 B(-)
M I sG
1:n Connection
Termination External Device side External Device side
resistance Terminal Block ~ Terminal Block
2200(1/4W) Signal name | Signalname |  Termination
Display D1 resistance
g A(+) A(+) %220()(1/4W)
D
0 B(-) B(-)
() NS SG SG
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(€8] PFXZLMCBRIRS1

+ Connect External Devices using side connectors.

NOTE I
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4K)

¢ 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
ominston [Pin [Sora]  svitd - [Sgalrame | ormetr
1000 2 |DATA+ [e———A——>  A(+) %1000
Display % 1 |DATA- <——/ \——~> B(-)
3 | NC | P SG
7 | N |
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block ~ Terminal Block
Termination Pin |Signal name Shield Signalname | Signalname |  Termination
resistance ol ~ | L ...._. resistance
1000 2 |DATA+ [e——A—  A(+) A*) %1009
Display % 1 |DATA- <—.—/ L—» B(-) B(-)
3 | NC | i P SG SG
7 | Nnc | i
5 GND
4 NC
8 NC
9 NC
6 NC
Shell | FG

» Connect External Devices using side connectors.
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6 Supported Devices

The following table shows the range of supported device addresses. Please note that the actually supported range
of the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

Input address of external device in the dialog below.

T\ DevicalPLC [pct =] 3
o [=[[ooo1
Back | oar
ale|c 7|a]a
D|E 4[5]s
2 1]2]3
\Referenoe | 0 Ent

1. Device Set Device.

2. Reference The list of available identifiers is displayed.
Click the identifier to use and press "Select," and the address is entered.

3. Address Set Address.
The combination of identifier and address differs depending on the external device.

BThe following description explains the memory maps for each parameter.

<When using Bit Data>
Bit Data (Read Only) : Function [02H]

Ej(l;z: Coil No.” Type CI\:/IoiTeonrtys Read-out Data
0000H 10001 Bit Alarm1 ON/OFF | 0: Alarm1 OFF, 1: Alarm1 ON
0001H 10002 (Reserved)
0002H 10003 (Reserved)
0003H 10004 (Reserved)
0004H 10005 Bit Alarm2 ON/OFF | 0: Alarm2 OFF, 1: Alarm2 ON
0005H 10006 (Reserved)

*1  Coil No. is the address that is assigned by the Display.
Example: For the parameter "Alarm1 ON/OFF" of Coil No. 10001, the Display’s designated address is as follows.
Use the first digit of the Coil No. (00001 -, 10001 -) to designate the device.
10001

Address (The last four digits of the Coil No.)
Device (The first digit of the Coil No.)

GP-Pro EX Device/PLC Connection Manual 71



Temperature Controller MODBUS SIO Driver

Example: For the parameter "front surface control SV data" of Register No. 41003, the Display’s designated address
is as follows. Use the first two digits of the Register No.s (30001 -, 40001 -, 31001 - and 41001 -) to

designate the device.
41 003

Address (The last three digits of the Coil No.)

Device (The first two digits of the Coil No.)

» The External Device’s parameter data, when data transfer is performed, will have no
decimal places. Thus, in the Display, processing must be performed to correct the data.
For example, if a numeric display is used that includes decimal places, the "No. of
Decimals" of the "Display" settings must be used. Also, when writing data to a External

Device, it is necessary to write decimal values as integers.

Example: Register No. 41025’s "Output 1 Lower Limit"
External Device Display/Setting Value : 3.00%
Display value/setting : 3000

Please refer to your External Device manual for details (with/without a decimal point)

about data item setting value ranges.

6.1 PXH series
(=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30257 - 31407 L L& 31712
Word Data 40001.00 - 45035.31 40001 - 45035 ‘ ML e dl] 2

*1  Write disabled.
*2  This device is 32 bits in length. Only odd addresses can be assigned.

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

*4 43153 is an address to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
» Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.2 PXG series
[E=——1 This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Bit Data 10001 - 10013 - *
Read Only Word Data (Internal) - 30001 - 30062 9]
Read Only Word Data HiL ]
(Engineering Unit) ) 31001 - 31062 Lt ERRIE] 15
Word Data (Internal) 40002.00 - 40628.15 40002 - 40628 9] ™
Word Data (Engineering Unit) | 41002.00 - 41628.15 41002 - 41628 9] ™

*]1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
* Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.3 PXR (AutoFIX) / PXR (NoAutoFIX) series

[E=——1 This address can be specified as system data area.

Device Bit Address Word Address 32bits Notes
Bit Data 00001 - *
Read Only Bit Data 10001 - 10016 10001 15+ 1 | *2

Read Only Word Data (Internal) - 30001 - 30037

m *1%3
m *1%3

*1 00001, 40001, and 41001 are addresses to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

*2  Write disabled.

HIL

Read Only Word Data

(Engineering Unit) . 31001 - 31037

Word Data (Internal) 40001.00 - 40120.15 40001 - 40120

Word Data (Engineering Unit) 41001.00 - 41120.15 41001 - 41120

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"

« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

6.4 PUM series (PUMA / B)

[E=——1 This address can be specified as system data area.

Device Bit Address Word Address 32bits Notes

Read Only Word Data - 30001 - 34061

‘HIL|

Word Data
*1  Write disabled.

40001.00 - 45032.15 40001 - 45032

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"

« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.5 PUM series (PUME)
[E=——1 This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30064 - 31003 HIL 9]
Word Data 40021.00 - 41016.15 40021 - 41016 ‘ e 9]

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"

6.6 PUM series (PUMV /N /T)
=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30001 - 34061 HiL 9™
Word Data 40017.00 - 45032.15 40017 - 45032 ‘ LA e dh ™

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE * You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device codes and address codes when you set "Device Type & Address" for the address type of the data

display or other devices.

71 PXH series
Device Cod
Device Device Name evice Lode Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address -1) divided by 2
Word Data 4 0000 Value of (word address -1) divided by 2
7.2 PXG series
Device Code
Device Device Name v Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Reaq OnIY Word. Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.3 PXR (AutoFIX) / PXR (NoAutoFIX) series
Device Code
Device Device Name v Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Reaq OnIY Word. Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.4 PUM series
Device Cod
Device Device Name evice ~ode Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address - 1)
Word Data 4 0000 Value of (word address - 1)

GP-Pro EX Device/PLC Connection Manual
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8 Error Messages

Error messages are displayed on the Display screen as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem Description

No. Error number

Name of the External Device where an error has occurred. Device/PLC name is the title of

Device Name the External Device set with GP Pro-EX. (Initial value [PLC1])

Error Message Displays messages related to an error that has occurred.

Displays the IP address or device address of the External Device where an error has
occurred, or error codes received from the External Device.

Error Occurrence Area NOTE

 IP address is displayed as "IP address (Decimal): MAC address (Hex)".
» Device address is displayed as "Address: Device address".
» Received error codes are displayed as "Decimal [Hex]".

Examples of Error Messages
"RHAAQ035:PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE » Refer to your External Device manual for details on received error codes.
» Refer to "Display-related errors" in "Maintenance/Troubleshooting Manual" for details on the

error messages common to the driver.

W Error Codes Unique to External Device

Error Code Description
0x02 Faulty address for coil or resistor
0x06 Busy condition

GP-Pro EX Device/PLC Connection Manual ﬁ
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